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Comandos do Autodesk Inventor 

Este útil guia rápido de referência resume alguns dos mais impor-
tantes comandos do Autodesk Inventor:

Undo    :   O comando Anular desfaz as acções tomadas durante a sessão de edição 

em curso, começando pela mais recente. Utilizar o botão de Anular per-

mite-lhe tentar aplicar novas ideias, mas elimina parte do risco.

Redo   :    O comando Refazer desfaz as acções do comando Anular.

Os seguintes comandos são utilizados para manipular vistas. Os ícones destes comandos podem ser encon-

trados na barra de ícones standard. É possível mostrar/esconder a barra de ícones standard indo a Vistas > 

Barra de ícones e seleccionado/ desseleccionando o campo junto a Standard.

Zoom All  :     Este comando muda a factor de zoom da vista, para que a totalidade do 

modelo seja mostrada no seu ecrã.

Zoom Window :  Pode utilizar este comando para fazer zoom numa área específica do seu

desenho. Seleccione o ícone e seguidamente clique uma vez para espe-

cificar um dos cantos da janela de zoom. Clique uma segunda vez para 

especificar o segundo canto da janela de zoom.

Pan  :    Este comando permite-lhe mudar a porção do modelo que é apresentado 

no ecrã. Seleccione o ícone e mantenha o botão esquerdo do rato premido 

e mova o rato para reposicionar o seu modelo. 

Rotate   :   Pode utilizar este comando para alterar a orientação do seu modelo no 

ecrã. Após seleccionar o ícone, o símbolo de órbita (um círculo com quatro 

linhas) aparece no ecrã. Pode agora rodar o modelo, mantendo o botão 

esquerdo do rato premido e movendo o rato para cima e para baixo ou 

para a esquerda e direita. Se iniciar o movimento do rato fora do círculo, 

o modelo roda sobre um eixo perpendicular ao ecrã. Se iniciar o movi-

mento do rato próximo de uma das linhas, o modelo rodará sobre um eixo 

definido pelas outras duas linhas. Importante: Um único clique com o botão 

esquerdo do rato (em vez de mantê-lo premido) define um novo centro de 

rotação. Pressionar a tecla Shift simultaneamente com o comando Rodar o 

modelo, permitir-lhe-á iniciar uma rotação “permanente” do seu modelo.

Lembre-se: Termine sempre os comandos de manipulação de vistas com um clique no botão direito do 

rato e seguidamente seleccione Done no menu de contexto que aparece. Em alternativa, pode também 

premir a tecla ESC (Escape) no seu teclado.

Olhar Para :     Este comando reorienta a vista em que olha directamente para uma face 

específica ou para um esboço. Seleccione o ícone do comando e seguidam-

ente seleccione a face para a qual pretende olhar. O modelo auto reorienta-

se suavemente, podendo então visionar directamente a face desejada.



Tecla F2:     Premir a tecla F2 no seu teclado activa o comando Pan. Mantenha a tecla F2 premida 

e seguidamente clique e arraste (ou seja, mantenha também pressionado o botão 

esquerdo do rato) o seu modelo para a posição desejada.

Tecla F3:     Premir a tecla F3 chama o comando de Zoom. Mantenha a tecla F3 premida e seguida-

mente, pressionado também o botão esquerdo do rato, poderá ampliar ou reduzir o 

seu modelo.

Tecla F4:    Premir a tecla F4 activa o comando Rodar o modelo. Pode reorientar o seu modelo 

da forma descrita acima. Tecla Shift mais F4 permite iniciar uma rotação “permanente” 

do modelo 

Tecla F5:      Premir a tecla F5 retorna à orientação de vista anterior. A tecla Shift mais F5 avança 

para a orientação de vista seguinte.

Quando utilizar estes atalhos de teclado, não necessita terminar os comandos em ESC.

Vista Isométrica:  Na maioria dos casos, a vista isométrica é mais indicada para modelar em 3D. Pode 

sempre mudar a sua orientação de vista para vista isométrica através de um clique no 

botão direito do rato e a partir do menu de contexto, seleccionar Isometric View.

Nota: Sempre que ao utilizar o Autodesk Inventor tiver dúvidas sobre a função de um determinado ícone, 

deixe simplesmente o cursor sobre ícone e aparecerá uma Dica.

O presente manual foi patrocinado pela HP. 
 Para seleccionar plataformas de alto desempenho adequadas ao Autodesk Inventor, por 
favor visite www.hptechcomp.com/autodesk

Traduzido e adaptado por Micrograf, com a colaboração do Engenheiro Vitor Louro - AFTEM/ESTEM. 
Distribuido por:
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Autodesk Inventor

Estimado Profissional de Projecto,

Obrigado pelo seu interesse no Autodesk Inventor. Criámos esta versão gratuita de teste por 30 dias do 

Autodesk Inventor para oferecer ao maior número de profissionais do ramo a possibilidade de verificarem 

por si mesmos quão fácil se tornou trabalhar em CAD 3D.

Agora já pode aceder a todas as características de projecto 3D – sem a inconveniência de todas aquelas 

demoradas transições. Com Autodesk Inventor, pode obter produtividade desde o primeiro dia.

O Autodesk Inventor permite-lhe concentrar-se nas formas, ajustes e funções – e não perder tempo com 

o software. As características intuitivas do Inventor – como menus simplificados, opções seleccionadas de 

forma inteligente e ferramentas para apontar e reparar falhas – adaptam-se à forma como trabalha. Teste-o, 

e descubra o ambiente de projecto mais aberto que alguma vez experimentou.

A revolucionária tecnologia adaptativa do Inventor elimina as limitações do projecto paramétrico. Verá que 

poderá lidar facilmente com grandes montagens. E cada utilizador poderá sempre contar com informação 

actualizada. A tecnologia adaptativa  do Inventor aumenta extraordinariamente a produtividade – alca-

nçando os mesmos resultados em metade dos passos necessários num sistema tradicional.

O Autodesk Inventor é a solução centrada no processo de desenvolvimento da totalidade de um produto, 

permitindo-lhe trabalhar de forma mais eficaz com os seus parceiros. Os seus produtos poderão assim 

chegar mais rapidamente ao mercado. E quando a chegar a hora de gerir o seu negócio on-line, o Inventor 

está preparado para a Internet.

O presente manual vai ajudá-lo a dar os primeiros passos com o Autodesk Inventor. Para tal, escolhemos 

um exemplo relativamente simples: uma trotinete. Para poupar tempo, preparámos já para si alguns 

componentes. Para poder utilizá-los, é necessário copiar para o seu sistema alguns ficheiros do CD que se 

encontra na bolsa posterior deste manual (ver adiante para explicações adicionais).

O presente manual foi redigido a pensar em utilizadores iniciados, sendo no entanto necessária alguma 

experiência com aplicações de base Windows. Se necessitar de informação adicional, por favor contacte o 

seu revendedor Autodesk.

Incluímos também um capítulo que mostra como desenhos de AutoCAD podem ser facilmente reutilizados 

no Autodesk Inventor, demonstrando assim que o Inventor é a progressão natural para os utilizadores que 

queiram expandir os seus projectos para o mundo de 3D.

Obrigado mais uma vez pelo seu interesse no Autodesk Inventor. Agora descubra como o projecto 3D 

pode ser fácil! 

 

Martin Budgell e Wolfgang Lynen, Autodesk
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Tire o Máximo Partido da sua Versão de Teste por 30 dias

Requisitos do Sistema 
Requisitos mínimos do sistema para a versão de teste do Autodesk Inventor:

• Pentium ® II, Pentium II Xeon ™, ou equivalente

• Windows ® 98, Windows ME, Windows NT ® 4.0 SP6a, ou Windows 2000 Professional SP1

• Microsoft Internet Explorer 5.5 (pode ser encontrado no CD)

• 360 MB de espaço livre do disco rígido

Nota: Esta configuração é válida para este exemplo. Para utilização profissional é recomendada uma 

configuração superior.

Instalação do Software 
Para instalar a versão de teste do Autodesk Inventor e copiar 

os ficheiros do test drive trotinete, por favor siga os seguintes 

passos:

1. Encerre todas as aplicações abertas.

2. Insira o CD na drive de CD-ROM e siga as instruções que 

surgirem no ecrã.

3. Se o CD não se iniciar automaticamente, entre em ‘X:\testdrv.exe em que  ‘X’ designa a letra da drive de 

CD, e faça um duplo clique no ficheiro testdrv.exe.

4. Por favor, seleccione uma das seguintes cinco opções:

 • Instalar a versão de teste a 30 dias

 • Instalar os ficheiros demo trotinete 

 • Ver manual test drive 

 • Ver animação final do conjunto 

 • Ligar ao site da HP, que patrocinou o presente 

manual

Para instalar a versão de teste de 30 dias
Clique no botão Instalar a versão de teste de 30 dias. Siga 

as instruções no ecrã. 

Primeiro instale o Microsoft Internet Explorer 5.5. Isto 

é necessário para permitir o funcionamento do Design 

Support System e a tecnologia de i-Drop. Depois instale o 

Volo View Express 2.0. Isto pode ser mantido após o período 

de 30 dias para a visualização de todos os tipos de ficheiros. 

O Autodesk Inventor utiliza o Volo View na pré-visualização 

e configuração de importação de ficheiros de AutoCAD e 

Mechanical Desktop (.dwg). Finalmente clique no ícone de 

Instalar Autodesk Inventor 5.

Por favor, seleccione a opção Single User Licence. 

Por favor, seleccione Install Inventor as 30 day trial



 4

Tire o Máximo Partido da sua Versão de Teste por 30 dias

Nota: Após os 30 dias do período de teste se terem esgotado, o sistema não permitirá uma reinstalação.

Para instalar os ficheiros demo trotinete 
Após a instalação da versão de teste do Autodesk Inventor, é necessário copiar para o sistema os ficheiros 

do modelo. Para tal, é necessário clicar no botão Baixar Arquivos. Ao clicar neste botão, ser-lhe-á pedido 

para escolher o caminho onde deseja instalar os ficheiros. 

Nota: Recomendamos que instale os ficheiros no seguinte directório C:\Program Files\Autodesk\Inventor 

5\Tutorial Files se utilizar a versão Inglesa do sistema operativo, ou no directório C:\Programas\Autodesk\

Inventor 5\Tutorial Files se utilizar a versão Portuguesa do sistema operativo. Esta é a localização pré-

definida dos ficheiros de tutorial do Inventor; se, no entanto, instalou o Inventor num caminho diferente, 

por favor certifique-se que os ficheiros trotinete são copiados para o directório Tutorial Files desse caminho.

Ver manual (em inglês) 
Esta opção permite visionar o presente manual em formato electrónico.  

Ver animação final do conjunto 
Esta opção permite-lhe visualizar a animação da trotinete.

Visite o site do nosso patrocinador 
www.hptechcomp.com/autodesk  

Selecione dimensões em Milimetres Seleccione ISO como norma de desenho

Mantenha inalterada a opção ”Enable part modification from within drawings“. 
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Ajustando o seu PC
De forma obter os melhores resultados e 

uma boa apresentação gráfica do seu trab-

alho, por favor siga estas dicas simples para 

ajustar o seu PC:

Optimizar os parâmetros dos gráficos: A 

partir do Ambiente de Trabalho, clique 

com o botão direito do rato, seleccione 

Propriedades (Propriedades do Monitor), 

e seleccione o separador Definições: selec-

cione True Color.

Afinação para computadores portá-
teis, etc.
Se por um lado o Inventor optimiza auto-

maticamente o seu PC durante a utilização, 

os passos seguintes poderão ser eficazes 

para quem trabalhe em sistemas com baix-

os recursos. 

Inicie o Autodesk Inventor, cancele o 

ecrã QuickStart, seleccionando Cancelar no 

canto inferior direito. Seguidamente, a par-

tir menu vertical de Tools, seleccione Application Options. No separador Cores desseleccione (desligue) 

a caixa intitulada Show Reflections. Seguidamente seleccione Apply e OK para fechar a caixa de diálogo. 

Agora encerre o Autodesk Inventor, seleccionando File > Exit.

Para obter mais informação relativa às definições da placa gráfica, por favor visite o seguinte site: 

http://support.autodesk.com/inventor-graphic-cards.
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Iniciar o Autodesk Inventor

Inicie o Autodesk Inventor seleccionando o 

ícone Inventor  no ambiente de trabalho. 

É mostrada a caixa de diálogo do Código de 

Autorização. Junto do topo pode ler um aviso 

que lhe indica quantos dias tem ainda para utili-

zar o produto. É lhe perguntado se deseja autor-

izar o Autodesk Inventor, adquirir o Autodesk 

Inventor, ou iniciar o Autodesk Inventor. Seleccione simplesmente o campo Run Autodesk Inventor e 

clique em Seguinte.

Na página Começar poderá também encontrar 

uma ligação ao Point A. O Point A é um 

recurso de projecto on-line que fornece toda a 

informação para profissionais de projecto, inclu-

indo actualizações, notícias da indústria grupos 

de discussão do produto. Esta ligação só funcio-

nará se existir uma ligação activa à Internet.

Na página Começar poderá encontrar uma 

ligação à RedSpark, Inc. A RedSpark permite aos 

engenheiros de projecto, gestores de aquisições 

e cadeia de fornecimento trabalhar em conjunto 

com os seus parceiros de manufactura, melho-

rando a eficiência em cada fase de desenvolvimento de um produto. A RedSpark fornece também uma 

biblioteca de catálogos de peças que podem ser inseridas directamente nas montagens Autodesk Inventor. 

O terceiro ícone na página Começar fornece uma ligação ao Autodesk Streamline. O Autodesk Streamline 

é um serviço hosted  que permite partilhar instantaneamente  dados digitais de projecto com toda a sua 

equipa alargada de manufactura. O Autodesk Streamline permite o acesso a informação de projecto a partir 

de qualquer lugar, qualquer altura, sem ter de descarregar ficheiros CAD, imprimir um desenho, ou abrir um 

pacote CAD. O Autodesk Streamline funciona com base em tecnologia streaming que permite acesso de 

alta velocidade a dados através da Internet.



7 

Interface do Utilizador

Interface do Utilizador

Na área O Que Fazer (What to do) à esquerda do ecrã Começar (Getting Started),  seleccione Projectos 

(Projects), e faça um duplo clique no projecto denominado Tutorial_Files. Desta forma assegurará que o 

Autodesk Inventor encontrará sempre os seus ficheiros trotinete.

Agora, na área O Que Fazer (What to do) à esquerda do ecrã Começar (Getting Started), seleccione Novo, 

(New) e abra uma peça standard fazendo um duplo clique no ícone Standard.ipt . 

Poderá agora visualizar a interface do utilizador do Autodesk Inventor. Se isto lhe parecer familiar, por 

ser semelhante ao Windows, lembre-se: é mesmo Windows. No topo encontra os comandos normais 

do Windows que lhe dão acesso aos menus verticais. Por exemplo, em Ficheiro (File), poderá encontrar 

comandos como Guardar (Save), Imprimir (Print) e Sair (Exit). No menu vertical Ver (View), poderá 

encontrar comandos para orientação de vistas e do modelo como Rodar (Rotate), Pan e Zoom. A secção 

Ajuda (Help) fornece-lhe acesso ao sistema alargado de ajuda on-line do Autodesk Inventor.

Na 2ª linha encontra-se a barra de ícones do Autodesk Inventor. Os comandos nesta barra de ícones 

podem ser utilizados para:  

• Executar tarefas de ficheiro Novo (New), Abrir (Open), Guardar (Save), Imprimir (Imprimir)

• Explorar o seu projecto (Zoom, Pan, Rodar)

• Aceder ao Sistema de Apoio ao Projecto (sistema de ajuda) (Help)

• Executar tarefas gerais de modelação.
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À esquerda poderá encontrar a Barra de Painel (Panel 

Bar)(acima) e o Browser (abaixo). 

A Barra de Painel é um conjunto especial de ferramen-

tas. Quando abre uma nova peça, a Barra de Painel 

contém uma série de comandos de esboço (Sketch). 

Quando terminar o seu esboço, a Barra de Painel muda 

automaticamente para Geometria (Feature).  Deste 

modo, são apresentados poucos ícones ao mesmo 

tempo, conforme as necessidades. A Barra de Painel 

tem dois modos: Aprendizagem e Expert. O modo 

Aprendizagem mostra as ferramentas com as 

descrições, enquanto que o modo Expert mostra ape-

nas os ícones das ferramentas. Por pré-definição, a 

Barra de Painel abre no modo Aprendizagem. Se efec-

tuar um clique com o botão direito do rato na barra que 

contém o nome do conjunto de ferramentas corrente, 

pode comutar entre os modos Aprendizagem e Expert, 

e também seleccionar outros conjuntos de ferramentas. 

Pode arrastar a Barra de Painel para onde desejar. Se 

fechar a Barra de Painel, pode abri-la novamente selec-

cionado Ver(View) > Barra de ícones (Toolbar)> Barra de 

Painel (Panel Bar).

A Barra Browser encontra-se por pré-definição abaixo 

da Barra de Painel. Quando projecta uma peça, o 

browser exibe as características que adicionou ao seu 

modelo. A estrutura da peça é apresentada grafica-

mente como uma “árvore de modelo”. Ao trabalhar 

no ambiente de montagem, o browser exibe a estru-

tura das peças e submontagens contidas na montagem 

principal. Uma vez que o nosso modelo é novo, o 

browser encontra-se praticamente vazio. Pode arrastar 

o browser para onde desejar. Se fechar a Barra Browser, 

pode abri-la novamente, seleccionando Ver(View) > 

Barra de ícones (Toolbar)> Barra Browser (Browser Bar).

Ambas as barras de Painel e Browser podem ser redi-

mensionadas do mesmo modo que no Windows. Pode 

também alargar a janela gráfica para o tamanho máxi-

mo fazendo um duplo clique na barra azul no topo da 

janela gráfica.
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Vamos Projectar

A primeira peça que vamos projectar é a abraça-

deira superior da direcção. Esta é a peça que fixa 

o guiador à coluna de direcção..

1. Ambiente de Esboço (Sketch)
Quando inicia um ficheiro de uma nova peça, 

o modo de esboço encontra-se já activado. Na 

janela de esboço, é visível uma grelha. Esta grel-

ha torna o esboço mais fácil, uma vez que for-

nece uma referência visual relativa ao tamanho 

e à posição. A origem do esboço localiza-se no 

centro da janela, onde se encontram as setas 

encarnadas, verdes e azuis. No modo de esboço, 

a Barra de Painel contém ferramentas de esboço 

como comandos de Linha, Círculo e Arco.

2 Esboço da linha de base 
Inicie o esboço seleccionando o comando Linha  a partir da Barra de Painel. Movimente o rato sobre 

a área de esboço. O cursor torna-se num ponto amarelo. Agora desloque-se para o ponto inicial do seu 

esboço, como na figura, e clique com o botão esquerdo do rato. Desloque o rato para a direita e verá que 

surge uma linha dinâmica verde. Quando a linha está próxima da horizontal o sistema indica-o, através de 

um símbolo horizontal cinzento  junto do cursor. Desloque o rato na horizontal para o ponto final da 

primeira linha e clique novamente. Acabou agora desenhar a linha de base do seu esboço.

Por favor, certifique-se que a linha horizontal tem um comprimento de cerca de 20 espaçamentos de 

grelha. Assim que começar o seu esboço, um campo denominado “Comprimento”, próximo do canto 

inferior esquerdo do ecrã, indica-lhe qual o comprimento da linha enquanto esta é criada. A linha horizontal 

não necessita ter exactamente 20 uni-

dades (40 mm); no entanto, se a linha 

for muito comprida ou muito curta, 

posteriormente a peça poderá não se 

ajustar à montagem da trotinete.

Por favor, note que quando fizer um 

erro, pode sempre voltar atrás, clican-

do no ícone Undo  na barra de 

ícones; depois basta clicar novamente 

no comando Line na Barra de Painel.

start point

ª

end point

ª

Aqui é onde encontrará 

o comando de Linha

ª

length fieldª
+
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3. Esboço da linha vertical
O comando de linha ainda está activo e por isso pode adicionar uma segunda linha ao seu esboço. 

Desloque o rato para cima, na vertical. Quando a linha estiver próximo da vertical, aparece um símbolo 

perpendicular cinzento  junto ao cursor, indicando que a linha que vai desenhar está a 90 graus da 

primeira. Uma vez que este é o resultado pretendido, desloque o rato na vertical, certificando-se que está a 

gerar uma linha vertical e acabe a segunda linha com outro clique do botão esquerdo do rato.

4. Adicionar um semicírculo ao 
esboço
Podemos executar esta tarefa enquanto 

o comando de Linha ainda está activo. 

Desloque o rato exactamente sobre o 

ponto final da segunda linha. Verá que 

o cursor passa de um ponto amarelo 

para um ponto cinzento. 

Agora clique e arraste (isto é, mantenha 

premido o botão esquerdo do rato), 

deslocando o rato para cima e para 

a esquerda, gerando assim dinamica-

mente um arco. Desloque aproximada-

mente o rato para a posição da figura, 

de modo a poder desenhar um arco 

com aproximadamente 180 graus. Solte 

o botão esquerdo do rato para criar um 

arco.

5. Fechar o perfil do esboço
O comando de Linha ainda está activo. 

Desloque o cursor até ponto inicial do 

seu esboço e verá que o ponto amarelo 

passa a verde quando se ajusta ao ponto 

final. Clique para fechar o perfil do 

esboço.
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6. Adicionar um círculo
A partir da Barra de painel (Panel Bar), seleccione o comando Center Point Circle  . Desloque o cursor 

para o ponto verde no centro do arco. Verá que o cursor muda novamente a cor para verde, indicando que 

está ajustado a uma geometria já existente. Clique com botão esquerdo do rato e afaste o rato, gerando 

assim um círculo. Clique quando o círculo atingir aproximadamente o tamanho mostrado na figura. 

Terminou o layout do esboço. De 

forma a terminar o comando de cír-

culo, clique com o botão direito do 

rato. Aparecerá um menu de contexto: 

seleccione Done neste menu. Em vez 

de clicar com o botão direito do 

rato em Done, pode apenas premir a 

tecla ESC (Escape) no seu teclado; esta 

operação também encerrará o coman-

do activo de Círculo.

7. Adicionar Restrições
Dependendo da localização exacta dos 

seus cliques com o rato, o esboço 

pode ter um aspecto “perfeito” ou 

um pouco distorcido. Se as linhas não 

estiverem exactamente na horizontal 

ou na vertical, poderá agora efectuar 

correcções. Use a barra de translação 

do lado direito da Barra de Painel para rolar para baixo a Barra de Painel até atingir o fundo. Encontrará aí o 

comando Perpendicular, e junto a ele, uma pequena seta a apontar para baixo. Esta seta indica que existem 

mais comandos disponíveis. Pode utilizar estes comandos para 

adicionar restrições à sua geometria. 

Clique na seta descendente  , e aparecerá um menu de 

ícones. Seleccione o ícone de restrição apropriado: por exemplo, 

se desejar tornar a linha inferior horizontal, seleccione o ícone 

Horizontal  e de seguida clique na linha inferior. Se desejar 

tornar as linhas esquerda e direita exactamente verticais, seleccione o ícone Vertical  e a seguir clique 

na linha correspondente. Se adicionar acidentalmente uma restrição a uma linha que já tenha essa restrição, 

surgirá uma janela que o informará que a restrição já existe; pode fechar esta janela seleccionado o botão 

Cancelar.

Termine a adição de restrições clicando no botão direito do rato e em Done ou premindo a tecla ESC no seu 

teclado. Lembre-se: se errar, pode sempre voltar atrás com o comando Undo
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8. Verificar o esboço
Agora é possível verificar o seu esboço, 

“arrastando-o”. Ao deslocar o cursor 

sobre a geometria do esboço, ou as 

linhas ou os pontos finais são destaca-

dos. Desloque-se para a linha inferior, 

clique e mantenha premido o botão 

esquerdo do rato. Agora é possível 

arrastar a linha inferior para uma nova 

posição. Pode também clicar e arrastar 

o arco. Pode verificar que o ponto final 

esquerdo do arco não é tangente à 

linha vertical. Para corrigir isto, tere-

mos de adicionar uma outra restrição 

ao esboço. 

9. Adicionar uma restrição tan-
gencial
Por favor, note que o comando de 

restrição na Barra de Painel do princípio exibia o comando Perpendicular. Agora, dependendo do último 

comando que executou, pode exibir o comando Vertical ou Horizontal. Clique na seta descendente e 

seguidamente no ícone Tangente   . Agora clique na linha vertical e no arco. Termine este comando 

clicando no botão direito do rato e em Done ou premindo a tecla ESC. 

Note que agora é possível arrastar livremente o esboço e que tudo está correcto.

10. Qual a dimensão do seu esboço?
Para descobrir, vamos adicionar manualmente algumas cotas. Apesar de com o Inventor se poder gerar 

diversos tipos de cotas, como por exemplo, lineares, angulares, radiais e diâmetros, o Autodesk Inventor 

possui apenas um único comando para adicioná-las, uma vez que é capaz de reconhecer automaticamente 

qual o tipo de cota que necessita de 

ser desenhada. Esta característica torna 

a tarefa de cotagem muito fácil para o 

utilizador. 

11. Adicionar cotas
Na Barra de painel (Panel Bar), des-

loque-se para cima e seleccione o 

comando General Dimension  . 

Adicione uma cota vertical clicando 

na linha vertical direita. Seguidamente 

desloque o rato para a direita; é 

mostrada uma pré-visualização da 

cota. Clique para posicionar a cota. 
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12. Definir o valor
O valor da cota depende da localização exacta dos cliques do rato durante o esboço. Queremos modificar 

a altura para exactamente 30 mm. Para tal, basta clicar na cota. É exibida a Caixa de Diálogo de Edição de 

Cotas. O valor actual da cota é destacado. Agora basta digitar no seu teclado o valor 30 e premir a tecla 

Enter ou clicar no ícone com o traço Verde  no lado direito da Caixa de Diálogo de Edição de Cotas. 

Uma vez que o Autodesk Inventor é 

totalmente paramétrico, a geometria 

do esboço foi adaptada ao novo valor 

de altura.

13. Adicionar mais cotas
Agora queremos adicionar uma cota 

para a espessura do anel. Clique 

no círculo interno e seguidamente 

no círculo exterior. É mostrada uma 

pré-visualização da cota, indicando 

a distância entre os dois círculos. 

Desloque o rato e clique para posicio-

nar a cota. Lembre-se que foi criado 

um valor arbitrário. Para obter o valor 

exacto desejado, clique novamente na 

cota e é mostrada a Caixa de Diálogo 

de Edição de Cotas. Digite o valor cor-

recto (5) no seu teclado e clique no 

ícone com o traço Verde. A dimensão 

do círculo foi modificada de acordo com o pretendido. Termine o comando Cotagem Geral clicando no 

botão direito do rato e em Done ou premindo a tecla ESC. 

Nota: Ao introduzir uma cota utilizando o teclado, não é necessário digitar “30 mm”. Basta apenas 

digitar “30”, uma vez que já elegeu a unidade mm como pré-definição. O Autodesk Inventor entende 

a totalidade dos sistemas unitários, quer métrico, quer  imperial, podendo mesmo utilizar os dois em 

simultâneo no mesmo desenho. Lembramos que, ao contrário de outros sistemas CAD, não é necessário 

adicionar a totalidade das cotas ao modelo – basta adicionar as que são importantes para o seu projecto.

Nota: por agora deve apenas adicionar as cotas mostradas, caso contrário isto afectará a flexibilidade 

necessária numa fase posterior. Se adicionou mais cotas, por favor elimine-as, terminando o comando 

Cotagem Geral com um clique do botão direito do rato e em Done, ou premindo a tecla ESC, e seguida-

mente clicando numa cota. A cota é realçada e pode ser eliminada premindo a tecla Delete no seu 

teclado.
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Transformar o esboço 
num modelo 3D 

Chegou a altura de transformar o 

esboço 2D num modelo 3D. De forma 

a visualizar melhor o modelo 3D, é 

possível mudar a orientação da vista. 

Até agora a vista incidiu directamente 

sobre o plano de esboço. É por 

isso necessário mudar para uma vista 

isométrica. A vista isométrica propor-

ciona uma melhor representação para 

modelos 3D. 

1. Entrar no mundo 3D 
Mude para a vista isométrica clicando no botão direito do rato. Dentro do menu apresentado, seleccione 

Vista Isométrica (Isometric View). Por favor, note que as cotas ficam sempre viradas para si, independente-

mente da orientação do modelo.

2. Terminar o esboço
Para deixar o ambiente de esboço, clique no botão direito do rato e seleccione o comando Terminar Esboço 

(Finish Sketch) no menu de contexto que é mostrado. Notou certamente que o Autodesk Inventor torna 

as tarefas de projecto o mais simples possível – na  maioria dos casos, o comando seguinte está apenas à 

distância um clique do botão direito do rato. 

Pode verificar que a grelha desapareceu, pois esta só é necessária para as tarefas de esboço. Pode também 

verificar que os comandos de esboço na 

Barra de Painel foram substituídos por 

comandos de geometria. 

3. Criação de sólidos
Para o nosso modelo, será utilizado o 

comando Extrudir (Extrude). Clique no 

ícone Extrude  , e é mostrada a 

Caixa de Diálogo Extrudir. Agora deslo-

que o rato no esboço e clique no meio 

da geometria de esboço, como na figu-

ra.

�

ª

Transformar o esboço num modelo 3D 
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Termine a selecção de perfis a 

extrudir clicando com o botão 

direito do rato e seleccionado 

Continue. É mostrada uma pré-

visualização gráfica do modelo 

3D. 

Desloque o rato para uma aresta da pré-

visualização até esta mudar de cor. Agora 

pode simplesmente clicar e arrastar (man-

tendo o botão do rato premido) a extrusão 

até à altura desejada. Pode verificar que o valor 

na Caixa de Diálogo Extrudir é actualizado auto-

maticamente. Pode também introduzir aqui as cotas dese-

jadas. Para destacar este valor, faça um duplo clique no valor 

mostrado no campo da altura de 

extrusão. Introduza o valor desejado 

(20). Agora seleccione OK.   

Parabéns! Acabou de criar o seu 

primeiro modelo sólido com o 

Autodesk Inventor. 

4. Zoom, pan e rodar
Chegou a altura de examinar o mo-

delo. Com o Autodesk Inventor, esta 

operação pode ser executada facil-

mente e em qualquer altura. 

Em primeiro lugar, clique no ícone 

Zoom All   na barra de ícones 

Standard. O modelo aparecerá de 

modo a que todos os elementos apareçam na janela gráfica.

Agora clique no ícone Rotate the Model  na barra de ícones Standard. Aparecerá o símbolo Órbita em 

forma de círculo. Desloque o rato para dentro do círculo Órbita, clique e mantenha o botão esquerdo do 

rato premido. Ao deslocar o rato pode reorientar facilmente o modelo e vê-lo a partir de diversas direcções. 

Termine o comando Rodar o modelo da forma habitual - com um clique do botão direito do rato e com 

Terminar (Done), ou premindo a tecla ESC.

Se não conseguir obter a vista desejada, pode sempre voltar à vista isométrica com um clique do botão 

direito do rato e seleccionando Vista Isométrica (Isometric View).
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5. Dar uma nova cor ao modelo

Se desejar, pode dar uma cor diferente 

ao modelo. Clique na seta descendente 

  no campo Colour na barra de 

ícones inferior, como é mostrado. Aparece um 

menu vertical, podendo agora seleccionar qualquer 

cor ou material que desejar. Para este componente o 

material escolhido é Metal-Al-6061 (Flat).

Nota: se desactivou a função Reflexos, conforme 

indicado na página 5, algumas das cores não podem 

ser exibidas correctamente.

6. Guardar o seu trabalho
Chegou a altura de guardar o seu trabalho. Clique no 

ícone standard do Windows Save . É mostrada a Caixa de Diálogo Guardar Como. No campo Nome do 

ficheiro, escreva um nome como My Steering Clamp. Certifique-se que este novo ficheiro é guardado no 

directório correcto: C:\Program Files\Autodesk\Inventor 5\Tutorial Files.

Volte à vista isométrica.
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Adicionar detalhes

É necessário adicionar uma ranhura e 

cortar algum material. Esta operação é 

feita novamente recorrendo ao esboço 

e seguidamente à extrusão.

1. Cortar uma ranhura
O primeiro passo é definir um novo 

plano de esboço. Seleccione o ícone 

Sketch    na barra de ícones, 

e seguidamente clique na superfície 

superior do modelo. Verá que a grelha 

reaparece – como é normal no modo 

de esboço – e que a Barra de Painel 

voltou a exibir os comandos de esboço.

2. Olhar para o esboço
Pode executar o esboço em qualquer orientação, mas por vezes é mais simples olhar directamente para o 

plano de esboço. Esta operação é muito fácil com o Autodesk Inventor. Basta clicar no ícone Look At  

, e clicar novamente na superfície superior do modelo. Verá que o modelo roda suavemente, tornando a 

reorientação fácil de seguir. 

3. Esboçar a ranhura
A partir dos comandos na Barra de Painel (Panel Bar), escolha o ícone Two Point Rectangle . 

Execute o esboço conforme é mostrado. Como ponto inicial, seleccione um ponto na linha base a aproxima-

damente 2 espaçamentos da grelha a par-

tir do canto inferior esquerdo; Pode verifi-

car que a linha base muda de cor quando 

o cursor está próximo; isto significa que 

o ponto inicial ficará situado exactamente 

na linha base. Agora clique; acabou de 

definir o primeiro canto do rectângulo. 

Agora arraste o canto oposto do 

rectângulo para perto do círculo. Pode 

verificar como o canto se ajusta ao círculo 

e como o círculo muda de cor. Neste 

momento deve clicar novamente. Depois 

de desenhar o rectângulo, o comando 

rectângulo ainda está activo. Como sem-

pre, poder terminar um comando de duas 

formas: com a tecla ESC no seu teclado ou 

com um clique no botão direito do rato e 

seleccionando Terminar (Done).

superfície superior

ª

x

ponto de fim

x

ª

ponto de inicioª

x
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4. Posicionar a ranhura
Poderá verificar que o esboço da 

ranhura não está centrado, por isso 

é necessário torná-lo simétrico. Esta 

operação é possível arrastando o 

esboço. Desloque o rato para qualquer 

canto do rectângulo e verá que este 

é destacado. Desloque cuidadosa-

mente o rato até ao canto superior 

esquerdo e verá que este é destacado. 

Seleccione o canto com um clique no 

botão esquerdo do rato, mantendo-o 

premido, e arraste o canto em direcção 

ao círculo. O círculo muda de cor, 

como anteriormente, e o rectângulo 

ajusta-se à posição correcta.

Se não conseguiu obter o resultado 

desejado, pode sempre voltar atrás cli-

cando no ícone Undo  .

5. Dimensionar a ranhura
Se o rectângulo parecer muito grande, basta clicar em qualquer linha vertical do rectângulo, manter o botão 

esquerdo do rato premido e arrastar a linha até à posição desejada, tornando-o assim mais pequeno. Se 

desejar cotas precisas, seleccione o ícone General Dimension  na Barra de Painel (Panel Bar) e adicione 

uma cota horizontal, como acima. Este valor pode ser alterado para o valor desejado clicando na cota 

e inserindo o valor correcto. Neste caso, 6 mm. Confirme este valor clicando no ícone Traço Verde  

ou premindo a tecla Enter no teclado. Termine 

o comando Cotagem Geral com um clique no 

botão direito do rato em Terminar (Done) ou com 

a tecla ESC. 

6. Cortar a ranhura
Regresse à vista isométrica premindo a tecla F5 no 

teclado – este atalho de comando volta sempre à 

orientação de vista anterior – ou, em alternativa, 

com um clique no botão direito do rato, seleccione 

Isometric View. Termine o modo de esboço com 

outro clique no botão direito do rato e seleccionando 

Terminar Esboço (Finish Sketch).

Como seria de esperar, a grelha desapareceu e a Barra de Painel exibe os 

comandos de Geometria. Seleccione o comando Extrude  . Agora clique no 

meio do rectângulo que esboçou. A área do rectângulo é destacada.

No meio da Caixa de Diálogo Extrudir, seleccione o ícone Cut  . É mostrada uma pré-visualização da 

ranhura. No campo Extensão à direita da Caixa de Diálogo Extrudir, seleccione a seta descendente  junto 
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ao texto Distânce. O valor neste campo determina a profundidade do corte a executar. Uma vez que este 

deve atravessar todo o modelo, clique em Tudo (All).  

É mostrada uma seta encarnada, indicando a direcção do corte. O sistema determinou automaticamente 

que o corte é descendente, pois é nesta direcção que se encontra o material. Execute o corte clicando 

no botão OK. 

7. Adicionar uma abertura curva
É agora necessário adicionar a abertura para o aperto. Adicione um esboço à face superior e olhe para a face 

superior. Tal como anteriormente, seleccione o ícone Sketch  na barra de ícones e a seguir clique na 

superfície superior do modelo. Agora clique no ícone Look 

At  e outra vez na superfície superior do modelo. 

8. Esboçar um círculo
A partir da Barra de painel (Panel Bar), seleccione o comando 

Center Point Circle  . Desloque o rato para junto do centro 

do furo no modelo; pode verificar que o cursor muda de ama-

relo para verde. Clique uma vez. Agora desloque o rato para 

a posição “três horas” no círculo exterior. Pode verificar que o 

círculo que está a arrastar se ajusta ao círculo exterior. Clique 

para gerar um círculo.

9. Criar outro círculo
Esboce outro círculo, definindo primeiro o centro no canto 

direito, a cerca de dois espaçamentos de distância do fundo; clique uma vez. Desloque o rato para junto 

do primeiro círculo. Quando o primeiro círculo ficar 

destacado, clique para posicionar o segundo círculo.

10 Adicionar uma linha
Seleccione o comando Line  a partir da Barra de 

Painel (Panel Bar) e adicione uma linha vertical. Na 

linha base do lado esquerdo localize cuidadosamente 

o ponto médio; pode verificar que o ponto do cursor 

passa de amarelo a verde quando o ponto médio 

é localizado. Clique para iniciar a linha neste ponto 

e seguidamente desloque-se na vertical para lá do 

círculo e clique para definir o ponto final da linha.
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11. Cortar o esboço
Agora é possível cortar os elementos 

desnecessários. Role para baixo na barra 

de Painel (Panel bar) e seleccione o 

comando Trim  . Corte os segmentos 

de linha e arco, como mostra a figura. 

Certifique-se que a porção superior do cír-

culo maior é cortada. Termine o comando 

Cortar da forma habitual (isto é, com um 

clique no botão direito do rato e Terminar 

(Done) ou com a tecla ESC).

12. Adicionar cotas
Neste momento, deve estar a pensar por 

que razão uma parte do esboço está 

verde. A razão é o arco não estar total-

mente restrito. Há por isso que adicionar 

as cotas em falta. Seleccione o comando 

General Dimension  na Barra de 

Painel (Panel bar). Seleccione o ponto 

final do arco onde este toca a linha base 

do modelo; este ponto é identificado por 

um único ponto encarnado. Agora selec-

cione o lado direito do modelo e posi-

cione a cota por baixo do modelo. Clique 

na cota e mude o valor para 5 mm.

13. Adicionar outra restrição
O arco ainda está assinalado a verde e necessita de uma restrição para ficar tangente ao círculo. Na barra de 

painel (Panel bar), role para baixo até Perpendicular. Clique na seta descendente  e seleccione o ícone 

Tangent  . Seguidamente clique em cada um dos arcos, à vez. Agora todas as linhas do esboço estão a 

preto, ou seja, estão totalmente restritas. Termine o comando Restrição com a tecla ESC.
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14. Remover mais algum material
Saia do modo esboço (Sketch) e volte 

à vista isométrica [um clique no botão 

direito do rato e Terminar Esboço 

(Finish Sketch), um clique no botão 

direito do rato e Vista Isométrica 

(Isometric View)]. Seleccione novamente 

Extrudir (Extrude) e clique no meio de 

cada um dos perfis, como na figura abaixo. 

Seleccione Cut  no meio da Caixa de 

Diálogo Extrudir. Seleccione também Tudo 

(All) no menu vertical Extensão (Extents) que 

é mostrado.

Execute o comando clicando no botão OK. Se sentir prob-

lemas ao seleccionar os perfis correctos, clique no ícone Undo e 

volte à operação de corte. Certifique-se que cortou a metade superior 

do círculo maior, como é indicado na secção 11 acima.

15. Bolear
Agora é necessário adicionar um pequeno boleado na aresta viva e ao mesmo tempo adicionar um boleado 

diferente ao lado esquerdo do aperto. 

Seleccione o comando Fillet   na 

Barra de Painel (Panel Bar) e é mostra-

da a Caixa de Diálogo Boleado. Se a 

caixa de diálogo cobrir parte do mod-

elo, pode mudá-la facilmente para um 

local mais adequado. Para tal, basta 

clicar e arrastar a barra azul no topo da 

caixa de diálogo.

Seleccione a aresta viva a bolear e 

será mostrada uma pré-visualização 

dos boleados (três arcos encarnados). 

Na Caixa de Diálogo Boleado, clique e 

mude o raio de 2 mm para 1. Agora 

clique em Clique aqui para adicionar 

(Click here to add). A seguir seleccione a linha vertical no lado esquerdo do modelo. Apesar desta linha não 

ser imediatamente visível, pode ainda assim ser seleccionada. Agora clique nos 2 mm da linha adicionada 

na Caixa de Diálogo Boleado e digite 3 no teclado como valor para o segundo boleado. Pode verificar que 

a pré-visualização do segundo boleado é actualizada. Clique em OK para executar o comando e gerar os 

boleados.

clique aqui. . .

ª

x

. . . e  a q u i

x

ª

aresta invisivel

x
ª

x

aresta viva

ª
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16. Esboçar um furo
Agora é necessário adicionar um furo no braço. Para tal é 

necessário activar o modo de esboço (Sketch) e olhar para 

o lado direito do modelo. Seleccione o ícone Rotate the 

model  e oriente o modelo tal como é mostrado. 

Seguidamente clique no botão direito do rato e em 

Terminar (Done) ou na tecla ESC para terminar este coman-

do.  

Seleccione o ícone Sketch  na barra de ícones e clique 

na face esquerda. Seleccione o ícone Look At   e clique nova-

mente na face esquerda.

Seleccione o comando Center Point Circle  . Toque na linha de base  e desloque-se ao longo desta até 

chegar a meio, altura em que o cursor deverá ficar verde. Desloque-se então, cuidadosamente para cima, 

não se afastando muito do pontilhado vertical, aproximadamente três espaçamentos. Poderá ser necessária 

alguma prática. Clique para posicionar o centro do círculo e arraste para fora um espaçamento, de forma 

a definir o tamanho do círculo. Termine o 

comando Círculo (como sempre: um clique 

no botão direito do rato e em Terminar 

(Done) ou com a tecla ESC).

Se clicou demasiado cedo e colocou inadver-

tidamente o círculo na posição errada, termi-

ne o comando de Círculo com ESC, e clique 

no ícone Undo  para recomeçar.

17. Posicionar o furo
De forma a dimensionar o círculo e colocá-lo 

na posição correcta, adicione duas cotas, 

como é mostrado. Seleccione General 

Dimension  na Barra de Painel e clique uma vez no círculo para gerar um cota de diâmetro. Clique 

novamente na cota e mude o valor para 5 mm. Com o comando de cotagem ainda activo, clique mais uma 

vez no círculo e em seguida na linha da base, e 

coloque a cota vertical à direita do modelo. Clique 

na cota e mude o valor para 9 mm.

Termine o comando com um clique no botão 

direito do rato e em Terminar (Done), e de segui-

da saia do modo de esboço com um clique 

no botão direito do rato e em Terminar Esboço 

(Finish Sketch).

lado esquerdo do 
braço

ª

x
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18. Terminar o furo
Utilize o comando Rotate the 

model  para posicionar o modelo 

como na figura abaixo e termine o 

comando com a tecla ESC. Agora selec-

cione Extrude  . Clique no interior 

do círculo que acabou de desenhar para 

seleccionar o perfil correcto, seleccione 

Cut  e, a partir do menu vertical Extensão 

(Extents) que é mostrado, seleccione Tudo 

(All). Pode verificar uma pequena seta encar-

nada a indicar a direcção do corte – na maio-

ria dos casos, o sistema é suficientemente inteli-

gente para determinar sozinho qual a direcção ade-

quada. Para completar o corte, seleccione OK na Caixa de 

Diálogo Extrudir.

19.  Remover todas as arestas vivas
O modelo tem já um aspecto atraente, mas contém ainda muitas 

arestas vivas. É possível remover essas arestas vivas com um sim-

ples comando: seleccionando o comando Fillet  , marque a 

caixa Arredondar Tudo (All Rounds) na caixa de diálogo. Poderá 

verificar a pré-visualização dos boleados. O valor de 0.5 mm é o 

adequado. Insira este valor na caixa de diálogo e poderá verificar 

a actualização dinâmica da pré-visualização. Seleccione OK para 

terminar o modelo.

20. Guardar o trabalho
Poderá verificar que a janela do browser contém agora diversos 

ícones, representando os passos individuais do histórico de mod-

elagem. Se deslocar o rato pela janela do 

browser, é destacada a geometria corre-

spondente de cada característica. Pode 

utilizar o browser para uma edição ou 

modificação adicional do modelo.

Parabéns! Terminou com sucesso o pro-

jecto da abraçadeira da direcção. É uma 

boa altura para guardar novamente o tra-

balho. Para tal, basta clicar novamente no 

ícone Save  .
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E os desenhos? O Autodesk Inventor permite-lhe gerar desenhos facilmente a partir das peças e das 

montagens criadas. Estes desenhos podem ser totalmente associados com modelos 3D para que, sempre 

que altere o modelo 3D, o desenho correspondente seja automaticamente associado. E vice-versa: quando 

o desenho de um modelo bidimensional é modificado, essa modificação reflecte-se também no modelo 3D.

1. Abrir um novo desenho
Seleccione File > New no menu que é mostrado e clique no ícone Standard.idw . Abrirá uma nova 

folha de desenho A3 com esquadria e título. Poderá também verificar que a Barra de Painel (Panel bar) se 

alterou com o conjunto de comandos apropriados: os comandos para geração de desenhos. 

2. Criar uma primeira vista
Seleccione o comando Create View   . 

Na Caixa de Diálogo Criar Vista (Create View), 

é possível alterar a escala para um valor de 

2. Poderá verificar que a pré-visualização está 

ligada ao cursor. Para colocar esta vista à 

esquerda do desenho, basta clicar.  

Poderá verificar que os boleados não apa-

recem no desenho, uma vez que, por pré-

definição, as vistas não exibem arestas tan-

gentes. Se desejar modificar esta definição, 

desloque o rato até ao centro da vista (evi-

tando pôr o rato sobre as linhas) e clique com o botão direito do rato. No 

menu de contexto, seleccione Editar Vista (Edit View)... marque a caixa 

Tangent Edges  na área Estilo (Style) e feche a caixa de diálogo com 

OK. Agora as arestas tangentes dos boleados serão exibidas.

3. Adicionar mais vistas
Para obter uma vista lateral, seleccione o 

comando Projected View  . Clique na 

primeira vista e arraste o rato para cima, e em 

seguida clique para colocar a vista de cima.

À medida que desloca o rato, poderá verificar 

as diferentes pré-visualizações para as vistas 

isométrica e lateral. Para adicionar mais vistas, 

basta clicar quando obtiver a posição dese-

jada. Para finalizar estas vistas, clique com o 

botão direito do rato e seleccione o botão 

Criar (Create). A sua folha de desenho deverá 

ter este aspecto.
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4. Adicionar uma vista em corte
Seleccione o comando Section View , clique na vista de 

frente, e de seguida clique uma vez acima e uma vez abaixo da 

vista para criar uma linha de corte vertical. Agora, seleccione o 

botão direito e seleccione Continue. Agora a vista de corte está 

ligada ao cursor. Desloque o rato para a direita, arrastando a 

vista de corte para o local desejado e clique para posicionar a 

vista. Poderá verificar que o corte não passa pelo centro da vista; 

para corrigir esta situação, terá de clicar e arrastar a linha de 

corte para uma nova posição. Verifica-se que a vista é automáti-

camente actualizada de acordo com a nova posição da linha de 

corte. Como já foi explicado anteriormente, também é possível exibir arestas tangentes na vista de corte.  

5. Sombrear as vistas
É possível acrescentar melhorias à vista 

isométrica, através de um clique no botão 

direito do rato sobre esta vista (evitando 

pôr o rato sobre as linhas) e, como antes, 

seleccionar a opção Editar Vista (Edit View)... 

Seleccione o ícone Sombreado  na área 

estilo (Style) e prima OK. A vista isométrica 

está agora sombreada.

6. Adicionar cotas
Agora é necessário adicionar algumas cotas. Clique na seta descendente  junto ao Gestor de Desenho 

(Drawing Management) na linha superior da Barra de Painel (Panel Bar) e seleccione Anotação de Desenho 

(Drawing Annotation). Em primeiro lugar, é necessário utilizar as cotas que definiram o modelo. Coloque 

o rato sobre a primeira vista na zona inferior esquerda da folha de desenho, clique com o botão 

direito do rato, e seleccione Capturar Cotas do Modelo (Get 

Model Dimensions). Poderá verificar que a totalidade das 

cotas paramétricas são colocadas automaticamente no 

desenho.

É possível efectuar zoom e pan à volta do modelo com os 

comandos habituais Zoom All   , Zoom Window   e 

Pan . Se não gostar da posição de algumas das cotas, é 

possível reorganizá-las. Para tal, basta clicar e arrastá-las para 

um novo local.
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7.Adicionar mais cotas
É necessário adicionar mais cotas para tornar o desenho mais com-

pleto. Seleccione o comando General Dimension  . Lembre-se: 

o Autodesk Inventor necessita apenas de um único comando para 

os diferentes tipos de cotas. Agora é apenas necessária uma cota 

vertical na vista de cima. Se tiver dificuldades em seleccionar as 

arestas correctas, basta seleccionar o comando Zoom Window  e aproximar-se da vista. Como pode 

verificar, a manipulação de vistas pode ser feita dentro deste comando.

Agora adicione uma cota de diâmetro à vista de frente. 

Dado que este círculo não está completo, a cota é pré-

definida para uma cota radial. Se preferir uma cota de 

diâmetro, basta clicar com o botão direito do rato e 

seleccionar Tipo de Cota (Dimension Type) e a seguir 

Diameter. Por favor note que o valor da cota resultante 

no desenho pode ser diferente, dependendo do tamanho 

do esboço.

8. Anotações adicionais
Seleccione o comando Center Mark  e clique em 

qualquer um dos círculos na vista de frente. Continue 

a clicar nos círculos nas outras vistas; serão adicionadas 

marcas de centro ao desenho. É possível adicionar outras 

anotações, como por exemplo tolerâncias, símbolos de 

soldadura e acabamento de superfície, conforme as 

necessidades.

Lembre-se – se não estiver satisfeito com 

o resultado, pode sempre voltar atrás, cli-

cando no 

ícone Undo  .

9. Guardar e fechar o aperto
Para guardar e fechar o desenho, selec-

cione Ficheiro (File) > Guardar (Save) e 

escreva na caixa de diálogo um nome 

como My Clamp Drawing. Depois selec-

cione Ficheiro (File) > Fechar (Close). Para 

fechar o modelo da abraçadeira, selec-

cione outra vez Ficheiro (File) > Fechar 

(Close).
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Montagem de Componentes

Agora é necessário colocar o aperto na montagem da trotinete. Uma monta-

gem é um conjunto de peças. Algumas destas peças podem ser restringidas 

umas às outras; por exemplo, um parafuso pode ser restringindo a um furo, 

como numa montagem verdadeira.

1. Abrir uma montagem
Seleccione Ficheiro(File) > Abrir (Open), de forma a abrir uma montagem 

denominada  Scooter Assembly (Montagem Trotinete). Pode verificar que a 

Barra de Painel (Panel Bar) mudou para o ambiente de montagem. 

A janela do browser exibe também a totalidade das peças contidas na monta-

gem.

A orientação gráfica da montagem pode ser diferente; de forma a exibir a 

montagem completa, basta ir ao topo da Janela do Browser e clicar na seta 

descendente à direita do ícone Design Views . No menu, seleccione Outros 

(Other). Seleccione Basic.Default na caixa de diálogo e feche com OK. A troti-

nete deve aparecer no ecrã como é mostrado abaixo.

2. Fazer Zoom na junta de direcção
Faça um zoom na ligação entre zona inferior 

e a zona superior da coluna de direcção. 

Seleccione o ícone Zoom Window   , clique 

ligeiramente abaixo e à esquerda da área onde 

quer ampliar, arraste a caixa de zoom sobre a 

área e clique uma segunda vez no canto superior 

direito da área desejada. Se conseguir obter a 

vista desejada pode sempre voltar à vista origi-

nal clicando no ícone Zoom All   , ou pre-

mindo a tecla F5 para voltar à vista anterior. O 

ecrã deverá ter o aspecto da figura à direita.
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3. Inserir um componente
Agora é possível inserir a abraçadeira da direcção na montagem. Seleccione o comando Place 

Component  na Barra Painel de Montagem e será mostrada uma janela. Utilize a barra de deslocamento 

para localizar e seleccionar o componente My Steering Clamp (ou o nome que tenha dado a este compo-

nente), e seleccione Open. O componente deverá aparecer no ecrã e estar fixo ao cursor. Aproxime-o da 

barra da direcção e clique para colocá-lo. Deverá ter cuidado em clicar uma vez, pois apenas é necessário 

colocar um exemplar da abraçadeira na montagem. Termine este comando da forma habitual: 

clique no botão direito do rato e em Terminar (Done) ou com a tecla ESC.

Se clicou duas vezes inadvertidamente e colocou duas 

fixações na montagem, seleccione o ícone Undo 

4. Rodar o componente
O componente foi colocado numa posição arbitrária; 

é possível alinhar aproximadamente a abraçadeira, 

seleccionando o comando Rotate Component  

na Barra de Painel (Panel Bar) e clicando na abraça-

deira. Aparecerá o já familiar símbolo de órbita, mas 

agora apenas ligado a um único componente. Utilize o 

rato para, aproximadamente, orientar a abraçadeira como 

é mostrado. Termine este comando da forma habitual: clique 

no botão direito do rato e em Terminar (Done)ou com a tecla ESC.

5. Aplicar restrições
Agora é necessário aplicar algumas restrições inteligentes para posicionar correcta-

mente o componente.

A partir da Barra de painel, seleccione o 

comando Place Constraint . É mostra-

da uma caixa de diálogo. Desloque o cur-

sor até ao furo maior da abraçadeira. Pode 

verificar que a linha de eixo é destacada 

automaticamente. Clique na linha de eixo 

para seleccioná-la. O sistema responde 

destacando a superfície interior. Agora 

desloque o cursor até à coluna de 

direcção. A linha de eixo é novamente 

destacada; clique na superfície exterior, 

também destacada – e a abraçadeira ajusta-se temporari-

amente à posição correcta (vide figura). Se o resultado 

desejado for este, pode agora tornar a restrição perman-

ente premindo o botão Apply.
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6. Verificar a restrição
Acabou de definir uma restrição. Isto significa que a 

abraçadeira ainda se pode mover para cima e para 

baixo na barra e rodar à volta desta. Se desejar ver 

o efeito desta restrição, feche a Caixa de Diálogo 

Restrição (seleccione Cancel). Agora clique e arraste 

a abraçadeira. Verá que os seus movimentos estão 

restringidos.

É óbvio que a abraçadeira é demasiado grande 

para se ajustar à coluna de direcção. Este tipo de 

alteração é muito fácil de efectuar com o Autodesk 

Inventor, devido à sua Tecnologia Adaptativa espe-

cial.

7. Modelagem adaptativa
“Adaptativo” significa que uma peça pode ser 

adaptada à geometria da montagem, onde esta é 

necessária. Neste exemplo, o diâmetro interior da 

abraçadeira irá adaptar-se ao diâmetro exterior da 

coluna de direcção. Algumas peças da abraçadeira 

foram deixadas propositadamente sem restrições 

(mais especificamente o diâmetro interior), para que 

estes elementos geométricos possam ser alterados.

8. Adaptar a abraçadeira
Para ajustar o tamanho da abraçadeira ao tamanho 

da barra, será utilizado o conceito de adaptativi-

dade. Para tornar a peça activa, faça um duplo clique 

sobre a abraçadeira da direcção. Poderá verificar que o resto da 

montagem se torna cinzenta. Na Janela do Browser localize a 

primeira extrusão (Extrusion1). Clique com o botão direito do 

rato na primeira extrusão e seleccione Adaptar (Adaptive). Poderá 

verificar que o símbolo de adaptabilidade  foi adicionado a 

Extrusion1 no Browser. Utilize o ícone Return  na barra de fer-

ramentas para voltar à montagem principal.
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9. Adicionar mais restrições
Agora é possível adicionar a 

restrição desejada; isto é, o furo 

da abraçadeira coincide com o 

diâmetro exterior do tubo. 

Seleccione o comando Place 

Constraint  , seleccione 

Tangent  no separador 

Assembly e no campo Solução 

(Solution), seleccione Inside . 

Clique na coluna de direcção e em seguida clique no furo da abraçadeira. Pressione OK e a abraçadeira irá 

ajustar-se automaticamente ao tamanho da coluna de direcção.

10. Associatividade total entre montagem, modelo e desenho
Esta operação gerou, dentro da própria montagem, uma mudança na geometria da abraçadeira. 

Obviamente que o desenho da abraçadeira será também actualizado. O Autodesk Inventor mantém sempre 

associatividade total entre peças e montagem.

11. Posicionamento final
Seleccione novamente o comando Place Constraint . Na caixa de diálogo 

do campo Solução (Solution), altere de 

Mate  para Flush  (Figura da direita). Agora seleccione a face superior da abraçadeira e em seguida a 

face superior da porção inferior da barra da direcção. Os topos das duas peças devem agora estar montados 

à mesma altura. No entanto, estas não irão ficar montadas à mesma altura mas sim com um afastamento 

de 5 mm. Para tal, basta inserir o valor 5 no campo Offset da Caixa de Diálogo Aplicar Restrição. Depois de 

seleccionar Apply, a abraçadeira é posicionada à altura correcta..

ª

primeiro seleccione a 
face superior da abraça-
deira...

... depois seleccione a 
face superior da barra

ª
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Ainda é possível rodar a abraça-

deira em torno do veio da 

direcção assim, para posicionar 

completamente a nossa abraça-

deira, vamos finalmente definir 

uma restrição angular. Na área 

de Type, seleccione o ícone 

Angle , seleccione a face 

da abraçadeira apresentada na 

figura, depois cuidadosamente 

seleccione a face interior da 

ranhura apresentada na figura, 

por fim seleccione OK e a 

sua abraçadeira ficou completa-

mente posicionada na monta-

gem. 

O parafuso da abraçadeira foi já 

montado de uma forma seme-

lhante, e como tal, é possível 

torná-lo visível: na janela do browser, role para baixo até encontrar o ícone de montagem cinzento 

 com o nome (Clamp Assy.iam)Montagem 

da Abraçadeira. Uma vez localizado, clique com o 

botão direito do rato. É mostrado um menu onde 

pode seleccionar Visibilidade (Visibility). O para-

fuso da montagem da abraçadeira é agora visível.

primeiro seleccione a 
parte superior da abraça-
deira. . .

ª
. . . depois selecci-
one a face da ran-
huraª
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Copiar geometrias existentes

É possível, durante a fase de projecto, poupar tempo reutili-

zando uma geometria já existente para um novo projecto. 

Para exemplificar isto, vamos efectuar uma ampliação da 

1ª caixa da direcção, para isso é necessário ir para a parte 

inferior da barra de direcção. Basta premir a tecla F2 para 

fazer panning (ou manter premido o botão do meio do rato 

com 3 botões ou com roda). Pode verificar que a abraça-

deira inferior da direcção ainda não está completa. Falta o 

furo para o parafuso de aperto.

1. Abrir uma peça.
É necessário abrir esta peça na sua própria janela. Clique 

primeiro com o botão esquerdo do rato sobre a peça e a 

seguir com o botão direito do rato, e seleccione Abrir (Open) no menu que é mostrado. Como já existe um 

furo adequado num projecto anterior, é preferível reutilizá-lo em vez de projectar um outro de raiz.

2. Abrir o projecto anterior
No menu Ficheiro (File), seleccione Abrir (Open). Na caixa de diálogo, procure a peça com o nome A Suitable 

Hole.ipt e seleccione OK para abrir esta peça.

3. Organizar diversas janelas
Agora é necessário dispor as peças junto uma da outra no ecrã. Para tal, seleccione Dispor Todas (Arrange 

All) no menu Janela (Window). Pode verificar que existem três janelas visíveis: a (Scooter Assembly.iam) 

Montagem Trotinete, a peça Steering clamp.ipt e a peça A Suitable Hole.ipt. Uma vez que a montagem não 

é necessária para esta parte do trabalho, pode minimizar esta janela. Para isso, clique primeiro na janela 

da montagem para activá-la e seguidamente clique no ícone Minimizar  no canto superior direito da 

janela da montagem. Seleccione novamente Janela (Windows) > Dispor Todas (Arrange All) para dispor 

as duas janelas restantes.
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4. Seleccionar geometrias 
Clique uma vez na janela A Suitable Hole.ipt, para tornar a janela activa 

e mostrar a informação de browser correspondente na janela browser. 

No topo do browser pode ver duas geometrias denominadas Select 

This Hole e And This Chamfer. Seleccione a geometria do furo com um 

clique do botão esquerdo do rato, e em seguida prima a tecla Shift 

e seleccione também o chanfro. Ambas as geometrias estão agora 

destacadas no browser assim como na janela gráfica.

5. Copiar geometrias
Agora é necessário arrastar estas geometrias do browser para a outra 

parte. Clique e mantenha premido o botão esquerdo do rato e des-

loque o cursor até à janela da abraçadeira da direcção e largue. É 

mostrada a Caixa de Diálogo Colar Geometrias. Se esta janela cobrir 

parte da abraçadeira da direcção, pode mudá-la de sítio: clique e 

arraste na barra azul no topo.

6. Colar geometrias
Agora é possível observar uma pré-visualização 

do furo. Quando passar o rato sobre o modelo, 

o furo ajustar-se-á às faces válidas. Na figura à 

direita, o furo aparece temporariamente na face 

frontal. No entanto, esta não é a opção desejada. 

Assim, é necessário deslocar o rato até à face 

vertical direita e clique para posicionar o furo. 

Para obter uma vista melhor, pode olhar para a 

face vertical. Para tal, clique no ícone Look 

At  e seleccione a face vertical direita

7. Posicionar geometrias
Desloque o rato sobre a cruz preta no centro 

do furo e clique. O furo está agora agarrado ao 

cursor. Desloque o furo aproximadamente até 

à posição e clique mais uma vez para posicioná-

lo. Seleccione Finish na Caixa de Diálogo Colar 

Geometrias. Agora o furo está posicionado no 

componente.

right vertical face

ª
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8. Posicionamento de precisão
Se desejar um posicionamento preciso do furo, siga os 

seguintes passos: no browser, clique com o botão direito do 

rato na geometria Furo  no menu e seleccione Editar 

Esboço (Edit Sketch). Na Barra de Painel (Panel Bar), role para 

baixo até Perpendicular . Clique na seta descendente  à 

direita deste ícone. Seleccione o ícone Concentric  e clique. 

Volte à janela gráfica. Seleccione o arco verde e também 

arco preto na abraçadeira. O arco verde desloca-se imediata-

mente para a posição correcta. Agora seleccione o ícone Voltar 

(Return) na barra de ícones e poderá ver que o furo está posi-

cionado de forma precisa

9. Fechar o projecto anterior
Feche a peça A suitable hole.ipt com um clique no ícone Close  no canto superior direito desta janela. 

Nota: não seleccione o ícone Fechar no topo do ecrã – esta operação encerrará a aplicação Autodesk 

Inventor.

Agora maximize a janela Steering Clamp.ipt, com um clique no ícone Maximizar .

10. Adicionar uma rosca
Nota: para utilizar esta funcionalidade, o seu 

sistema necessita de ter o Microsoft Excel 

instalado.

Reoriente o modelo com um clique no ícone 

Rotate  . É necessário olhar para a parte 

posterior do furo, como na figura. Role para 

baixo na Barra de Painel (Panel Bar) e selec-

cione o comando Rosca , e clique no furo, 

como indicado.

Seleccione OK para aplicar a rosca. Note que 

o Autodesk Inventor reconhece o tamanho do 

furo e aplica automaticamente a rosca cor-

recta. 

aplicar rosca aqui
ª
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iMate – Ajuste Inteligente de 
Componentes

Agora é necessário adicionar mais caracter-

ísticas de inteligência ao furo. Esta operação 

permitirá posteriormente colocar o parafuso 

da abraçadeira de forma automática. Para tal, 

reoriente o modelo como na figura abaixo.

1. Adicionar características de inteligência ao furo
Seleccione o ícone Create iMate  na barra de ícones standard. 

É mostrada a Caixa de Diálogo Criar IMate de Componente. Na 

área Tipo (Type), seleccione Insert  e em seguida seleccione o 

diâmetro do furo, como é mostrado, clique e seleccione Aplicar 

(Apply). Esta operação gera uma relação inteligente de peças 

entre a abraçadeira e qualquer outra peça que contenha a outra 

metade da interface, por exemplo, o parafuso. Seleccione Cancelar 

(Cancel) para fechar a caixa de diálogo. Poderá verificar que foi 

adicionado um pequeno símbolo cinzento de interface iMate.

2. Voltar à montagem
O parafuso com a outra metade da interface de peça encon-

tra-se já disponível; agora é necessário montar as duas 

peças. Guarde e feche a peça Steering Clamp.ipt seleccio-

nado Ficheiro (File) > Guardar (Save) e Ficheiro (File) > Fechar 

(Close); a montagem é exibida novamente no ecrã. Note que 

a abraçadeira na montagem foi actualizada automaticamente. O 

Autodesk Inventor mantém sempre uma associatividade total entre as peças e a montagem.

3. Posicionar o parafuso
Para posicionar o parafuso na montagem, seleccione o comando Place Component  na Barra de Painel 

(Panel Bar). Na caixa de diálogo que é mostrada, seleccione An M6x35screw.ipt. Primeiro marque a caixa (Use 

IMate)Usar Interface no canto inferior esquerdo da caixa de diálogo e em seguida seleccione Open. O para-

fuso é colocado em posição instantaneamente. Esta função só é possível porque foi definida uma restrição 

inteligente de ajuste para ambos os componentes, automatizando assim o processo de montagem.

seleccione o dia-
metro do furoª
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iParts – Famílias de Peças

Nota: para utilizar esta funcionalidade, o seu sistema necessita de ter o Microsoft Excel instalado.

Durante a fase de projecto, algumas peças assemelham-se com outras, divergindo apenas ligeiramente 

no tamanho ou nas características incluídas. O Autodesk Inventor fornece-lhe as ferramentas necessárias 

para criar diferentes versões a partir de um mesmo projecto. A estas peças chamamos iParts, ou peças 

inteligentes. As diferentes versões de um único projecto são armazenadas numa folha de cálculo. Sempre 

que uma iPart é utilizada, o utilizador é solicitado a escolher a versão que necessita. As suas cotas e 

geometria são lidas na folha de cálculo, permitindo ao sistema criar a peça automaticamente.

Para exemplificar o conceito iPart, será utilizada o punho do guiador, que tem de ser projectado com uma 

série de rebaixos interiores, dependendo do diâmetro do guiador.

 

1. Localizar o guiador
Efectue um zoom e pan ao topo da montagem, ou seja, a área do guiador. Esta operação pode ser efectuada 

seleccionando o ícone Zoom All  e depois o ícone Zoom Window  . 

2. Vista de perspectiva
Com a interface avançada de gráficos do Autodesk Inventor, também é possível visualizar os modelos 

em perspectiva. Para tal, seleccione a seta descendente à direita do ícone Ortographic Camera . É 

mostrada uma indicação; agora seleccione o ícone Perspective Camera . A vista deve ficar semelhante 

à ilustração abaixo.

3. Medir o guiador
Com auxílio da ferramenta de medição, é possível o diâmetro do guiador. Pode seleccionar o menu vertical 

Ferramentas (Tools) e em seguida seleccionar o comando Medir Distância (Measure Distance), ou pode 

aceder directamente a este comando com um clique no botão direito do rato sobre a janela gráfica e 

seleccionando Medir Distância (Measure Distance). Agora clique na superfície do guiador. É mostrado 

o diâmetro na pequena Janela Medir Distância. Memorize o resultado de 22 mm. Feche a Janela Medir 

Distância (Measure Distance) com um clique no Ícone Close .
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4. Inserir os punhos
Utilize o comando Place Component    na Barra de Painel (Panel bar). A partir da janela que é mostrada, 

seleccione a peça A Grip.ipt. Esta peça foi definida como sendo uma iPart, o que significa que o tamanho e a 

dimensão são variáveis. Neste caso, a variável é o diâmetro interior do rebaixo. Clique no valor pré-definido 

de 30 mm. É mostrada uma lista de tamanhos disponíveis. Seleccione um rebaixo de 22 mm e em seguida 

clique na montagem para posicionar uma peça. Clique novamente para posicionar a segunda peça. Uma 

vez que não é necessário adicionar mais componentes, termine seleccionando Cancel na caixa de diálogo.

5. Posicionar os punhos
Os punhos foram colocados arbitrariamente na montagem. De forma a colocá-los correctamente no guia-

dor, é necessário adicionar restrições. Seleccione o comando Place Constraints   a partir da Barra Painel 

(Panel Bar) de Montagem (Assembly). Será utilizada a restrição Insert  . No campo Solução (solution) 

mude a opção de Oposto (Opposed) para Aligned . Seleccione uma ponta do guiador e a ponta do 

um punho. O punho é colocado correctamente no guiador. Seleccione Aplicar (Apply) na Caixa de Diálogo 

Adicionar Restrição (Place Constraint) para finalizar. Repita o processo para o segundo punho. Finalmente, 

seleccione Cancel para terminar o comando. 

6. Adicionar realismo
Nota: Se, por motivos de desempenho, desac-

tivou a exibição de reflexos e texturas, como 

é descrito na página 5, a secção 

seguinte não funcionará correcta-

mente.

De modo a dar um aspecto mais real aos pun-

hos, é possível aplicar uma textura de superfície. 

Para este exemplo, seleccione os dois punhos. 

Pressione a tecla Shift e clique, à vez, em cada 

um dos punhos. No menu vertical Formatar 

(Format), seleccione Cores (Colors). É mostrada 

a caixa de diálogo Cores. Nesta janela selecci-

one o separador Textura (Texture) e em seguida 

clique em Escolher (Choose). É mostrada a janela 

Escolher Textura. Role para a direita até visualizar 

a textura No Skid_1.bmp. Clique nesta textura 

e seleccione OK para fechar a janela Escolher 

Textura (Texture Chooser). Se selec-

cionar agora Aplicar(Apply) na 

janela Cores (Colors), a textura é apli-

cada aos punhos. É possível jogar com a 

escala e a orientação da textura até obter 

o resultado desejado. Por fim, feche a janela 

Cores, seleccionando Close.
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Reutilizar Dados 2D

Há muitos anos que os projectistas utilizam sistemas CAD, ou AutoCAD, na maioria dos casos. Para estas 

pessoas é fundamental poder utilizar eficazmente desenhos já existentes. Para facilitar a reutilização destes 

dados, o Autodesk Inventor está equipado com poderosas ferramentas para importar dados 2D das mais 

variadas fontes.

Se desejar saltar esta secção, por favor continue a partir da tarefa 9 na página 41. 

Nota: uma vez que os dados a importar são predominantemente 2D, as vistas de perspectiva podem gerar 

confusão. Assim, recomendamos que volte à vista ortográfica. Para tal, seleccione o ícone Ortographic 

Camera  no menu vertical Vistas. 

1. Abrir um desenho AutoCAD 
Seleccione Ficheiro (File) > Abrir (Open). É mostrada a caixa de diálogo Abrir. No menu vertical Files of Type, 

seleccione AutoCAD Drawing (*.dwg). Na lista de ficheiros é mostrado o desenho Front Hub.dwg. Seleccione 

este desenho e clique em Options. É mostrada a janela Opções de Importação de Ficheiros DWG. Pode 

verificar que o sistema detectou automaticamente o formato do ficheiro, ou seja, um desenho AutoCAD. 

Como esta é uma peça projectada no sistema métrico, por favor seleccione mm no menu vertical Unidades 

do Ficheiro. Agora clique em Próximo (Next). É mostrada uma pré-visualização do desenho.



39 

Reutilizar Dados 2D

2. Seleccionar layers para translação
À esquerda da janela de pré-visualização pode 

observar uma lista de layers. Apesar de ser pos-

sível transferir o desenho como um todo, na 

maioria dos casos é mais eficaz  transferir ape-

nas o que é necessário. Neste caso, é apenas 

necessário transferir o contorno do cubo, ou 

seja, os dados contidos no layer 0. Para evitar 

a transferência de outros layers, desseleccione 

as respectivas marcas. Pode verificar que a jane-

la de pré-visualização é actualizada dinamica-

mente. Finalmente, como é necessário utilizar 

esta geometria para modelação, seleccione a 

caixa de verificação Constraints end points. Agora seleccione Próximo (Next).

3. Destino de importação
Os dados importados podem ser utilizados 

de diversas formas, como por exemplo desen-

hos, legendas e símbolos, etc. Neste caso, é 

necessário criar uma nova peça 3D. A partir da 

área Destination for 2D Data, seleccione New 

Part. As outras opções nesta janela permitem 

especificar modelos personalizados da empresa. 

Para iniciar a conversão, seleccione Finish e 

depois Open. A janela do Inventor está nova-

mente visível. Clique no botão Zoom Tudo 

(Zoom All) para centrar o esboço no ecrã. 

4. Capturar dados de esboço
Em primeiro lugar é necessário activar o esboço, 

uma vez que parte da informação será utilizada 

mais tarde no processo de modelagem. Na jane-

la Browser, faça um duplo clique em Sketch1 

(Sheet;1,Importdraftview,sketch1). Como é nor-

mal no modo de esboço, é mostrada a grelha. 

Começando no canto inferior esquerdo da vista 

da direita, arraste uma janela de contorno 

em cima da vista. Certifique-se que todos os 

elementos na vista da direita se encontram 

destacados. Agora clique com o botão direito do rato e seleccione Copiar (Copy) a partir do menu de 

contexto. Clique novamente com o botão direito do rato e seleccione Terminar Esboço (Finish Sketch). Foi 

colocada uma cópia na Área de Transferência na vista de frente para utilizar posteriormente.
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5. Passar a 3D 
Agora é necessário criar a forma básica da 

roda (por revolução) revolvendo o perfil da 

vista la-teral. A partir da Barra de Painel Panel 

Bar), seleccione Revolve . Destaque os perfis 

fechados, como é exemplificado. Na caixa de 

diálogo Revolver seleccione Axis e em seguida 

seleccione a linha de eixo da roda no esboço. 

Assim que o eixo for seleccionado, é mostrada 

uma pré-visualização. Seleccione OK para criar a 

forma básica do sólido de revolução.

6. Chamar o esboço
Oriente o modelo para uma vista isométrica 

(clique no botão direito do rato e em Vista 

Isométrica (Isometric view)). A partir da Barra 

de Comando, seleccione Sketch  , e clique 

na face anterior da roda, como é mostrado.

De forma a poder olhar directamente para o 

plano de esboço, seleccione o ícone Look At 

 e seleccione novamente a mesma face.

Terá agora de chamar (inserir) os dados de 

esboço capturados. Para tal, basta um clique no 

botão direito do rato e seleccionar Colar (Paste) 

no menu de contexto. Se o esboço não apa-

recer, clique no ícone Zoom All .

7. Deslocar o esboço 
Agora é necessário deslocar para o cubo o 

esboço que foi colado. A partir da Barra de 

Painel Esboço (Panel Bar Sketch), seleccione 

Move . Arraste uma janela sobre o esboço 

que foi colado. Quando este estiver destacado, 

clique com o botão direito do rato e seleccione 

Continue. Agora seleccione cuidadosamente o 

centro do esboço e em seguida o centro do cubo. Clique em Apply, e o esboço deve-se mover para a 

posição correcta. Feche a caixa de diálogo seleccionando Terminar (Done). Termine o esboço com um 

clique no botão direito do rato e em Finish Sketch.

�

�

�
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8. Criar raios
Para criar os raios, é necessário cortar o esboço que 

foi colado através do cubo. Na Barra de Painel (panel 

Bar), seleccione Extrude   , e seleccione cui-

dadosamente os 10 perfis, como é mostrado.  Quando a 

escolha é ambigua, aparece  o ícone Select Other .

Usando as setas pode percorrer as várias opções possíveis e quan-

do estiver em destaque a pretendida, seleccione o quadrado 

verde.

Na Caixa de Diálogo Extrudir, seleccione Cut  e na área 

Extensão, mude o tipo de terminação para Tudo(All). Clique em 

OK para efectuar o corte.

Como pode verificar, a transição dos dados AutoCAD 2D para o 

universo 3D foi feita um mínimo de esforço.

Guarde o trabalho com Ficheiro (File) > Guardar (Save) e 

feche o Hub com Ficheiro (File)> Fechar (Close).

Voltou agora à montagem da trotinete

9. Exibir a roda na montagem
De modo a poupar a tempo, o resto da sub-montagem da 

roda, já inclui o pneu e o rolamento. Agora é necessário 

torná-la visível. Na Barra Browser, procure uma montagem 

acinzentada  denominada Front Wheel Assembly. 

Clique com o botão direito do rato nesta submontagem e 

clique em Visibility. A roda aparecerá agora posicionada 

correctamente na montagem.
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Projecto em Chapa Quinada

O Autodesk Inventor possui poderosas capacidades de trabalho em chapa quinada incorporadas no próprio 

software. O trabalho de projecto com chapa quinada é um pouco diferente do das peças normais. Como 

a folha de chapa tem espessura, raios de curvatura e dimensões de relevo específicos (e que geralmente 

são os mesmos em toda a peça), o projecto deste material presta-se a processos de automatização. Numa 

peça em folha de chapa, basta introduzir estes valores uma única vez e o software aplica-os à medida que se 

efectua o projecto. Por exemplo, ao criar uma aba, não é necessário introduzir a curvatura manualmente.

Outro aspecto em que o projecto com chapa quinada difere da modelagem de peças é na obtenção da 

planificação. Dado que na manufactura uma 

peça em folha de chapa começa por ser uma 

peça plana de metal, é necessário converter o 

modelo numa planificação. 

1. Abrir uma submontagem
Como exemplo de uma peça em folha de 

chapa, escolhemos a suspensão dianteira da 

trotinete. Vamos trabalhar na peça Front 

Forks.ipt: Clique com o botão esquerdo do 

rato e em seguida com o botão direito do 

rato na suspensão dianteira e seleccione Abrir 

(Open). Acabou de abrir a submontagem 

Front Forks.iam. As submontagens são con-

juntos de peças individuais e, por vezes, ainda outras submon-

tagens; esta estrutura permite ao utilizador dar ao seu pro-

jecto uma estrutura com sentido. Neste caso, a submon-

tagem consiste apenas na Front Forks.ipt e no Front 

Wheel Carrier.ipt. 

2. Abrir uma peça em chapa quinada
Observe atentamente a suspensão em 

folha de chapa. Faça um duplo clique 

na suspensão e poderá verificar que 

o outro item na submontagem é destaca-

do a cinzento. Este sistema facilita a 

concentração do projecto, permitindo ao 

mesmo tempo reter uma visão geral da 

totalidade da montagem.
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3. Criar um padrão plano
Pode verificar que a Barra de Painel(Panel Bar) reconheceu automaticamente que este item é uma peça em 

folha de chapa, fornecendo por isso as ferramentas necessárias à complexidade do projecto com folha de 

chapa. No caso presente, não é necessário trabalhar o projecto, mas apenas gerar um desenvolvimento 

ou uma planificação que por norma é necessária à manufactura. Seleccione o comando Flat Pattern  

na Barra de Painel (Panel Bar)  e o desenvolvimento é gerado de forma automática. O Autodesk Inventor 

efectuou todos os cálculos matemáticos necessários para lidar com as folgas das curvaturas e exibir cor-

rectamente a planificação. É possível identificar as linhas de curvatura e zonas de curvatura na planificação. 

Note que a planificação continua a ser um sólido 3D e ainda mantém associatividade total com o modelo 

original.

Se pretender gerar um desenho de engenharia, pode incluir na mesma folha 

tanto os detalhes dobrados como os desdobrados. Feche a janela contendo 

a peça em folha chapa, seleccionando Ficheiro (File) > Fechar(Close). 

Quando o sistema perguntar se deseja guardar o modelo, responda 

No. Voltou agora à montagem principal da trotinete.
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Projecto de Peças de Plástico

Geralmente as peças de plástico necessitam de encaixar com outros compo-

nentes. Como exemplo, vamos projectar uma tampa para a plataforma extru-

dida.

1. Zoom na localização da tampa
Com o Inventor é possível especificar diferentes Vistas de Projecto que con-

trolam não só a orientação de uma montagem mas também a visibilidade 

dos seus componentes. Seleccione uma Vista de Projecto previamente selec-

cionada. Na janela Browser, clique na seta descendente junto ao ícone Design 

Views . No menu vertical, seleccione Other e depois End Cap View. Pode 

verificar que o resto da montagem se torna transparente por forma a melhorar 

a visibilidade.

2. Criar um novo componente
Amplie na secção esquerda do perfil. Agora é necessário 

criar um novo componente. Na Barra de Painel (Panel Bar), 

seleccione Create Component . Na caixa de diálogo, 

introduza o nome do novo ficheiro My End Cap, e selec-

cione OK. Agora seleccione a superfície superior do perfil 

extrudido, como é exemplificado, de forma a definir o 

plano de esboço inicial da nova peça. Pode verificar que 

o resto da montagem é esbatida, de modo a melhorar 

a percepção. Além disso, o modo de esboço foi também 

activado automaticamente.

3. Utilizar uma geometria existente
Agora é necessário copiar o perfil da plataforma e utilizá-lo 

para a criação da tampa.  A partir da Barra de Painel 

Esboço(Panel Bar Sketch), seleccione Project Geometry . 

Desloque o rato para a face final da extrusão, como é 

mostrado. No caso de aparecer o símbolo verde de selecção, 

utilize as setas para alternar entre os conjuntos selecciona-

dos disponíveis, até que o contorno da face fique destacado. 

Seguidamente, clique no quadrado verde central. Termine 

o esboço com um clique no botão direito do rato e em 

Terminar (Done) e com um clique no botão direito do rato e em Terminar Esboço (Finish Sketch). Ao criar 

a geometria de esboço desta forma, é gerado um perfil que permanece ligado ao perfil da plataforma. 

Como será demonstrado mais adiante, quaisquer mudanças feitas na plataforma, também influenciarão a 

tampa. 
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4. Modelar o interior da tampa
A partir da Barra de Painel Geometria, seleccione 

Extrude  e clique uma vez no perfil interior. Introduza 

uma distância de 20 mm. Certifique-se a direcção da 

extrusão vai para dentro da plataforma; se necessário, 

inverta a direcção com auxílio dos ícones de direcção. 

Para gerar a extrusão, seleccione OK. Para uma melhor 

visualização, vá ao menu vertical Color e altere a cor para 

Rubber (Black).

5. Modificar a plataforma
De forma a demonstrar a associatividade de duas partes, 

há que introduzir uma pequena modificação na plata-

forma. Clique com o botão direito do rato e seleccione 

Terminar Edição (Finish Edit); com esta operação regres-

sará até ao nível superior da montagem. Faça um duplo 

clique sobre o perfil para activá-lo. A partir da Barra de 

Painel Geometria (Panel Bar Features), seleccione 

Fillet  . Seleccione a aresta interior e um raio de 4 mm, 

como é mostrado. Clique em OK para criar o boleado e 

terminar o comando.
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6. Actualizar a tampa
Para voltar ao nível superior da montagem, clique com 

o botão direito do rato e seleccione Terminar Edição 

(Finish edit). A tampa é actualizada em função do 

boleado adicionado à plataforma. 

7. Terminar a tampa
Faça um duplo clique sobre a tampa para activá-la. 

A partir da barra de comando, seleccione o comando 

Sketch , e seleccione a face superior da tampa. Na 

Barra de Painel Esboço (Panel Bar Sketch), clique na seta 

descendente junto ao ícone Project Geometry . 

Seleccione o ícone Projec Cut Edges  e seleccione um 

ponto qualquer da plataforma. Este comando irá projectar 

automaticamente todas as arestas da plataforma cortadas 

pelo plano de esboço. Clique com o botão direito do rato e 

em Terminar (Done) e novamente com o botão direito do 

rato e em Terminar Esboço (Finish Sketch). Agora selec-

cione o comando Extrude  e seleccione o contorno 

exterior e interior, como é mostrado. Introduza o valor de 3 

mm na altura da extrusão e seleccione OK.

Para finalizar o projecto da tampa, é necessário adicionar um 

pequeno boleado. Seleccione Fillet  , e introduza um raio 

de 2 mm e seleccione o modo para Loop. Agora seleccione 

a aresta superior da tampa e clique em OK para gerar o 

boleado. Verá que foi aplicado o boleado para completar a 

face superior.

Para voltar ao nível superior da montagem, clique com o 

botão direito do rato e em Terminar Edição (Finish Edit).

Para visualizar a trotinete terminada, clique na seta descen-

dente junto ao ícone Design Views  na Janela Browser. No 

menu vertical, seleccione Scooter Finished View. Pode verificar 

que a toda a trotinete está agora visível.
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Criação de Vistas de Desenho Avançadas

O presente capítulo serve para demonstrar algumas das características avançadas e de economia de tempo 

incorporadas no Autodesk Inventor.

1. Abrir um novo desenho
Seleccione Ficheiro (File)> Novo (New), e abra um novo desenho com um clique no ícone 

Standard.idw . 

2. Localizar a plataforma
O desenho a criar não corresponde à totalidade 

da trotinete mas apenas à plataforma. 

Seleccione Create View  a partir da Barra 

de Painel Gestão de Desenho (Drawing 

Management). Na caixa de diálogo, clique no 

ícone Explore directories , como é mostra-

do.

Na janela resultante pode-se ver agora uma lista de todas as peças que compõem a trotinete. Percorra 

a janela à direita com a listagem dos ficheiros e localize a peça denominada Tread Plate Weldment.ipt. 

Clique nesta peça e poderá verificar que é mostrada uma pré-visualização à direita da janela. Agora 

seleccione Abrir (Open). A pré-visualização da 

elevação frontal encontra-se agora agarrada ao 

cursor.

3. Definir uma vista 
Na área Style na caixa de diálogo Criar Vista 

seleccione o ícone central  (Hidden Line 

Removed). Agora desloque a vista para o lado 

esquerdo da folha e clique uma vez para criá-la.
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4. Adicionar uma vista lateral
A partir da Barra de Painel Gestão de Desenho 

(Drawing Management Panel bar), seleccione 

Projected View . Desloque o rato para a área 

da vista de frente e clique uma vez. Ao deslocar 

o rato ligeiramente para a direita, é mostrada 

uma pré-visualização da vista lateral. Posicione a 

pré-visualização como no exemplo e clique uma 

vez para posicionar a vista. Como se trata da 

única vista projectada necessária, clique com o 

botão direito do rato e seleccione Criar(Create).

5. Criar uma vista quebrada
Como pode verificar, a vista lateral da plataforma excede as dimensões da imagem exibida. Clique em 

Zoom All  para exibir a totalidade da geometria.

Seleccione Broken View  a partir da Barra de Painel (Panel Bar) e clique na vista lateral (Side View). 

Certifique-se que não clica na sobreposição das duas vistas. É mostrada a caixa de diálogo Vista Quebrada.

Agora é necessário definir a secção da plataforma a remover pela vista quebrada. Clique uma vez à 

esquerda e uma vez à direita da plataforma, como é mostrado. Foi criada uma “vista quebrada”. No entanto, 

como pode verificar, esta foi colocada sobre a vista de frente. Arraste a vista lateral para a direita, clicando 

e arrastando-a, mantendo o botão esquerdo do rato premido. Clique em Zoom All  para exibir a 

totalidade do desenho. Como pode ver, é muito fácil optimizar o layout da vista do desenho com o Inventor.

clique aqui. . .

ª

. . . e aqui ª
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6. Adicionar anotações
Agora é necessário adicionar algumas cotas de base  à vista lateral. Clique com o botão direito do rato 

na Barra de Painel Gestão de Desenho(Drawing Management Panel bar) e seleccione Anotar Desenho 

(Drawing Annotation). Clique na seta descendente junto ao ícone General Dimension  no topo da 

Barra de Painel (Panel Bar). A partir do menu vertical, seleccione Baseline Dimension. 

O primeiro clique define o ponto base das cotas. Seleccione o furo do eixo posterior. Os cliques subsequen-

tes definem as geometrias a serem cotadas. Sugerimos que seleccione os furos restantes. Para criar as cotas, 

clique com o botão direito do rato e seleccione Continuar(Continue). As cotas estão agora agarradas ao 

cursor. Arraste-as até à posição desejada, vertical ou horizontal, e clique para posicioná-las. Pode verificar 

que os valores correctos são exibidos automaticamente tendo já em conta a secção que foi removida. 

Termine o comando com um clique no botão direito do rato e em Done.

Se desejar, pode adicionar mais anotações ao desenho. Quando este estiver completo, guarde e feche o 

desenho [Ficheiro (File) > Guardar (Save) e Ficheiro (File) > Fechar (Close)].
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Desenho da Montagem

A presente secção mostra como gerar um desenho da 

montagem da trotinete completa.

1. Abrir uma nova folha de desenho
Abra uma nova folha de desenho [Ficheiro (File) > 

Novo(New) > Standard.idw  ].

A Barra de Painel(Panel Bar) muda automaticamente 

para Gestão de Desenho/Drawing Management

2. Criar uma primeira vista
Na Barra de Painel Panel bar, seleccione Create 

View . No menu vertical Component File, certi-

fique-se que seleccionou o ficheiro Scooter Assembly. 

A vista de orientação pré-definida é Frente. Pode 

observar uma pré-visualização no cursor. No entanto, 

é necessário uma vista isométrica e para tal, deverá 

seleccionar Actual (Current) a partir do menu vertical 

Vista (view Pull-down menu). A pré-visualização desta 

orientação é alterada. Como é necessário uma vista sombreada, seleccione o ícone Sombrear  na 

área Estilo (Style). Desloque a pré-visualização para o canto inferior esquerdo do desenho e clique para 

posicioná-la. A escala foi determinada automaticamente pelo sistema para obter um ajuste óptimo na folha. 

No entanto esta função pode ser alterada posteriormente.

3. Criar uma vista detalhada
Dado que esta vista é demasiado pequena, é necessário criar uma vista com mais 

detalhe. Seleccione Detailed View  na Barra de 

Painel (Panel Bar) e clique uma vez na vista existente. 

Para determinar a posição e o tamanho do detalhe, 

clique novamente no topo da roda da frente e arraste 

o rato para longe. O sistema mostra um círculo que 

define os limites da vista detalhada. Quando atingir 

esses limites, clique novamente e a vista detalhada 

alargada ficará agarrada ao cursor.

Antes de posicionar a vista, mude o estilo para 

Sombreado  e desta feita mude a Escala para 0.5. 

Clique para posicionar a vista, aproximadamente no 

meio da folha. É mostrada a vista detalhada.

ª
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4. Identificar componentes
Agora é necessário identificar todas as peças contidas 

na vista detalhada. Para tal, clique na seta descendente 

 junto do cabeçalho Gestão de Desenho (Drawing 

Management) na Barra de Painel (panel Bar) e seleccione 

Anotar Desenho (Drawing Annotation). No fundo desta 

lista verá um comando denominado Balloon . 

Seleccione a Seta Descendente à direita deste comando 

e seleccione o ícone Balloon All  (o botão inferior). 

Agora clique na vista detalhada e seleccione OK na Caixa 

de Diálogo Numeração de Itens – Listas de Peças. Os 

balões são gerados automaticamente e distribuídos uni-

formemente em volta da vista detalhada. Se desejar 

mudar a posição de qualquer um dos balões, basta clicar 

e arrastar.



 52

Desenho da Montagem

5. Adicionar uma lista de peças
Na Barra de Painel (Panel Bar), seleccione Part List . É mostrado no cursor uma pré-visualização rectan-

gular. Desloque o cursor para a direita da folha de desenho. Note que a lista de peças se ajusta automatica-

mente ao contorno do desenho. Quando esta estiver em posição, clique para posicionar e a lista de peças 

será mostrada. A lista de peças exibe correctamente a totalidade dos componentes da trotinete. As colunas 

da lista de peças são totalmente personalizáveis de acordo com os seus requisitos, podendo também ser 

exportada para outras aplicações, como por exemplo o Microsoft Excel, etc. Se existir uma sobreposição 

entre a lista de peças e a vista, é possível reposicioná-la com um clique do rato e arrastando a vista para 

uma nova posição.

6. Imprimir o desenho
Se tiver acesso a uma impressora ou um traçador, pode imprimir o desenho da mesma forma que noutra 

aplicação Windows [Ficheiro (File)> Imprimir (Print)]. Pode agora encerrar o desenho [Ficheiro (File)>  

Fechar (Close)].
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Esta última secção serve para apresentar a forma como as montagens 3D projectadas com o Autodesk 

Inventor podem ser utilizadas em áreas como marketing, instruções de montagem, manutenção, etc.

1. Ambiente de apresentação
Agora é necessário mudar para um novo ambiente, o 

ambiente de apresentação. No menu vertical Ficheiro 

(File), seleccione Novo (New) e clique em Standard.ipn 

. Seleccione OK. A Barra de Painel (Panel Bar) mudou 

para um novo conjunto de comandos. Clique no ícone no 

ícone superior Create View . Certifique-se que selec-

ciona o ficheiro Scooter Assembly.iam. Certifique-se tam-

bém que o modo de explosão escolhido é Manual. 

Seleccione OK. Para ver a trotinete toda basta selec-

cionar Zoom All .

São necessárias instruções sobre como remover a 

roda da frente. Para tal, terá de ampliar esta área. 

Seleccione o ícone Zoom Window  e reoriente 

aproximadamente a trotinete como é mostrado.

2. Remover os parafusos
Seleccione Tweak Components  na Barra de Painel (Panel Bar). Poderá ter de deslocar a caixa de 

diálogo para ver o parafuso da roda da frente. Agora clique na cabeça do parafuso. É mostrado um 

indicador de coordenadas. Agora clique e arraste a seta que aponta para o eixo do parafuso, arrastando o 

parafuso para longe da roda. Para soltar este parafuso, seleccione Limpar(Clear) na Caixa de Diálogo. 

Agora é necessário reorientar o 

modelo de forma a poder observar 

o outro lado da roda da frente 

 . Clique na cabeça do outro 

parafuso. Que não conseguir iden-

tificar imediatamente qual das 

setas aponta na direcção correcta, 

basta rodar o modelo (com o 

próprio comando) até obter o 

resultado desejado. Arraste o para-

fuso para fora do modelo, como 

antes, e pressione Limpar(Clear). 

Apresentação da Montagem Completa
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3. Remover a roda
Finalmente é possível remover a roda. Esta é com-

posta por dois elementos: o cubo cinzento e 

o pneu cor-de-laranja. Clique no cubo (como 

no exemplo); é mostrada a seta de coordenadas. 

Agora seleccione ambos os componentes (os que quer 

remover),  e clique novamente no cubo. Pode veri-

ficar que este é destacado. Clique também no 

pneu para o destacar. Agora seleccione a seta 

que aponta para baixo, clique e arraste 

para remover a roda. Por fim, pressione 

em Fechar (Close) na Caixa de Diálogo 

Reposicionar Componente (Tweak 

Component Dialog Box).

4. Gerar uma animação da montagem
Agora já é possível observar uma animação do processo de montagem. Seleccione Animate  na Barra de 

Painel (Panel Bar). É mostrada a Caixa de Diálogo Animação. Se desejar, pode alterar o intervalo da variável 

para 10; este comando altera a velocidade da animação. Pressione o ícone Play Forward  (como num 

videogravador) e a roda e respectivos parafusos serão montados novamente. Quando estiver totalmente 

montada, a animação pode ser reprodu-

zida para trás. Note que orientação do 

modelo pode ser alterada, mesmo duran-

te a reprodução. A animação pode tam-

bém ser guardada num formato AVI nor-

mal, podendo ser visualizada em qualquer 

PC a operar em Windows. Feche a caixa de 

diálogo seleccionando Cancelar (Cancel).

5. Gerar uma animação de toda a 
montagem
Como exemplo do que pode ser feito 

com uma animação mais complexa, em  

Ficheiro (File) >  Abrir (Open), seleccione 

um ficheiro denominado A Finished 

Animation.ipm. Seleccione Animar 

(Animate) a partir da Barra de Painel(Panel bar) e reproduza a animação.

No CD incluído nesta apresentação pode encontrar um outro exemplo mais trabalhado, para efeitos de 

marketing ou publicidade. Este exemplo foi gerado com um outro produto da Autodesk, o 3D Studio VIZ, e 

com utilização directa dos ficheiros Trotinete  do Autodesk Inventor. O 3D Studio VIZ é uma ferramenta de 

criação de vídeos e imagens de qualidade fotográfica muito utilizada entre a comunidade de profissionais 

de projecto.
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Conclusão

Durante esta demonstração prática fornecemos uma breve descrição das capacidades do Autodesk 

Inventor. Esperamos que agora também seja da opinião que:

• O Autodesk Inventor é muito fácil de utilizar

• O Autodesk Inventor permite efectuar projectos 3D sem esforço

• O Autodesk Inventor resolve os seus problemas de projecto

No entanto, e como pode imaginar, apenas vimos os aspectos básicos. O Autodesk Inventor contém muitas 

mais funções e existem aplicações de terceiros que ampliam ainda mais as suas capacidades em áreas como 

análise de engenharia, CAM e gestão de dados de engenharia. Com o Autodesk Inventor e estas aplicações 

é possível cobrir toda a cadeia do processo, desde a concepção à produção.

Se tiver alguma questão sobre o Autodesk Inventor ou se desejar adquirir uma licença permanente, por 

favor contacte o seu vendedor Autodesk ou um representante da Autodesk. 

Obrigado mais uma vez pelo seu interesse pelo Autodesk Inventor. Esperamos que se tenha divertido com 

esta demonstração.
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